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Feedback

Two Keystrokes
Two keystroke tips that may be 

commonly known, though I’ve never seen 
them listed:
App Switcher

Once App Switcher is selected 
(Command/Tab), holding Command 
and pressing Tab moves you forward 
through the open apps. But what may be 
a lesser-known feature is that if, instead 
of Tab, you press tilde (immediately above 
the Tab key) the App Switcher moves 
backwards through the bar. Handy when 
you have dozens of applications open and 
you overshoot.
Safari

Similarly, everyone knows that pressing 
the Spacebar will scroll down one screen. 
Shift/Spacebar will take you in the 
opposite direction.

Michael Tippett

Consult the Dictionary 
One of my favorite little secrets in 

Tiger is the Dictionary/Thesaurus pop-up 
window that appears in applications such 
as Safari and Mail. Simply hover your 
cursor over any word and press Command/
Control/D to bring up a small window 
with the word’s definition. If you keep the 
control and Command keys pressed, you 
can then mouse over other words to see 
their dictionary or thesaurus entries as well. 

You can even highlight just part of a word 
(embark from disembarkation, for instance) 
to get the definition of a word within a 
word, or a part of a compound word (such 
as science from science fiction).  
~ Lloyd Viente

In regard to the above Dictionary/
Thesaurus feature, at the bottom right 
corner of the pop-up definition window is 
the word “More....” Click on it and you get 
the definition in a standalone window in 
the Dictionary application. This window 
is more flexible than the inline popup; 
you can copy and paste from it as well as 
change the font size.

Lynn Rybarczyk

Corrections

A Couple of Updates to Hints in the 
December Issue
	 1. 	You no longer need shareware to 

disable the cap locks key. In Tiger, go 
to the Keyboard & Mouse System 
Preferences. Click on “Keyboard” and 
then on “Modifier Keys...” For Cap 
Lock select the “No Action” pop-up.

	 2. 	Safari now emails links 
automatically. Go under the File 
menu to “Mail link to this page” 
(Command/Shift/I).

Bob Smallman, Merrill WI

Happy New Year!

These tips have been culled 
from user group newsletters, 
Macintosh-related books, 
magazines, and other sources. 
Thanks to all who have 
contributed and provided this 
valuable information to the 
Macintosh community.

Several hundred new tips are 
added to the Hints & Tips 
Database each month, with 
60–70 of them featured in this 
monthly newsletter.

If you haven’t used the 
searchable Database of tips 
available on this website, I 
urge you to give it a try. For 
$4.95, you can access the entire 
library of tips for a month. 
For $48, you can have access 
for a year. It is a lot easier and 
faster than going through a pile 
of newsletters and magazines 
looking for that tip you read 
about a few months ago.

If you like this newsletter, the 
best way to support it is to 
subscribe to the Database.

— Paul Taylor 
paul@mac-hints-tips.com
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General

Make Easy PDFs from Web Pages
Web pages change from time 

to time and in the past one could 
capture a whole web page using 
Internet Explorer for archiving the 
content. Now an almost magical 
way is to use Acrobat Pro 7. With 
Acrobat Pro active go to File > 
Create PDF > from Web Page. �en 
paste in the URL. Acrobat makes a 
PDF of the web page but that is not 
all! If there is a link on that PDF to 
another page, click on it and you 
now created another page in your 
original PDF. Cool!

Lynn Rybarczyk

Use Key Commands
�e Mac lead the way with 

mouse clicks, but Apple also 
always gives you a way to stay on 
the keyboard. When you realize 
how convenient certain keystroke 
shortcuts are, I suggest that you use 
my favorite teaching method. It is 
called “Punish Yourself.” Here is 
how it works. You want to Copy 
something. So you go to the Edit 
menu. �ere it is, Copy. But to the 
right of the word Copy there is a 
Command symbol and a C. You 
could just drop down to Copy and 
it executes the Copy command. But 
using my “Punish Yourself” plan, 
do NOT execute the Copy from 
the menu. Leave the menu and 
use Command/C. A half dozen 
trips to the menu and subsequent 
punishment and you will now 
automatically use the keyboard 
shortcut. Give my “Punish Yourself 

“plan a try. Like an old dog that 
cannot learn new tricks, the longer 
you wait, the harder this will be. I 
know! �ere are a lot of keyboard 
shortcuts that I still fail to use.

Mouse Droppings, Corvallis OR

Adding System Preference Menus
�ere are a number of iconic 

menus that you can add to the top 
right of your menu bar, providing 
shortcuts to common preferences. 
�ese menus include Volume, 
Displays, Battery, Classic, AirPort, 
Modem and PPPoE. You can 
add these items to your menu bar 
through the associated System 
Preferences. Just check the item 
to “Show [this module] in menu 
bar,” and it will appear. You can 
also get rid of one of these menus 
at any time by holding down the 
Command key while you drag it off 
the menu bar.

macHOME HotTips

A Typing Tutor
�ere was a time when typing 

tutors were a hot topic, and Mavis 
Beacon Teaches Typing and its 
ilk were among the hottest-selling 
software titles, yet I haven’t seen 
such a program advertised for years. 
I guess the youngsters are learning 
at school, and the oldsters have 
decided they’ll just plug along with 
two fingers.

If you have a bit of time to spare, 
I can’t recommend highly enough 
the acquisition of some basic typing 
skills. You mayn’t become a crack 
typist, but you will save an awful 
lot of time, and enjoy the time you 
spend on the Mac much more.

I recently tripped over a 
program named Key Advantage 
Typing, which costs only $19.95 
and can be downloaded from www.
programmingart.com/products/
key/. 

It requires Mac OS X (any 
version) and while I haven’t tried it 
out, the screenshots on the Web site 
indicate that it has all the ingredients 
of a classic typing tutor application.

If you are tired of taking half an 

hour to type a simple email, this 
could be what you are looking for. ~ 
Steve Cooper
AUSOM News, Melbourne, Australia

Avoid Voice Mail Runaround
Tired of the “voice mail” 

runaround? Go to http://
paulenglish.com/ivr/ to find the 
secret numbers and tips to bypass 
phone menus to get to a human.

Paul Taylor

Spring Cleaning!
Time to get out those lint-free 

cloths and go to work on your 
computer both externally and 
internally! Luckily, this isn’t as 
involved as my grandmother’s 
spring-cleaning. (Does anyone beat 
rugs anymore?) We’ll start with the 
outside of the computer.

Have you been looking at greasy 
fingerprints on your laptop or LCD 
display?
How to Clean the LCD

1. Turn off the computer or 
display. You may need to turn 
off the computer in order to 
turn off some Apple displays.

2. Dampen a clean, soft, lint-free 
cloth or paper with water only.

3. Wipe the screen. Do not spray 
liquid directly on the screen.

You may also use a mild glass 
cleaner that contains no alcohol or 
ammonia.

While there are many 
commercial products available 
that will work without damaging 
the plastics, Apple has tested 
a product called Klear Screen, 
made by Meridrew Enterprises, 
and found it does not cause any 
harm to the plastics. Packages 
of 12 Klear Screen sell for $9, or 
you can buy three packages for 
$23 <http://www.smalldog.com/
product/40942/atcontest/>

http://www.programmingart.com/products/key/
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How to Clean the Keyboard
Take care not to spill any liquid 

on the keyboard. If you do, turn 
off your computer immediately. 
Disconnect the keyboard from the 
computer immediately.

If you spill liquid that is thin 
and clear, turn off your computer, 
unplug the keyboard, turn it upside 
down to let the liquid drain out, 
and let it dry for 24 hours at room 
temperature. If after you take these 
steps the keyboard doesn’t work, 
take it to your Apple-authorized 
service provider for repair.

If you spill liquid that is greasy, 
sweet, or sticky, unplug the keyboard 
and take it to your Apple-authorized 
service provider for repair.

WARNING: Do not use acetone, 
alcohol, or any alcohol-based 
cleaner on your computer. Never 
spray cleaner directly onto your 
computer. Liquid could drip inside 
the screen or case and cause an 
electrical shock.

To get crumbs out of your 
keyboard, you can hold it upside 
down and give it a few shakes, 
use a clean brush to try to brush 
the crumbs out, or use a can of 
compressed air (be careful though, 
since these can contain moisture). 
When we are cleaning grimy, well-
used keyboards to prepare them for 
sale, we use a paper towel sprayed 
with Simple Green to clean up the 
keys. Again, don’t spray directly on 
the keyboard.

The best bet for a tidy keyboard 
is to cover it with a protector. The 
iSkin protectors do a good job 
without drastically changing the feel 
of the keyboard, though it does take 
some time to get used to the feel.

iSkin ProTouch PB Arctic 
White Keyboard protection 
for PowerBooks and iBooks: 
$19.99 iSkin ProTouch PB Sonic 

Blue Keyboard protection for 
PowerBooks and iBooks: 19.99 
iSkin ProTouch Abyss Indigo Blue 
Keyboard protection for Apple Pro 
Keyboards: $34 iSkin ProTouch 
White Frost Keyboard protection 
for Apple Pro Keyboards: $34. 
http://www.smalldog.com/search/
do_search.php?words=protouch/
Cleaning the Outside  
of the Computer

Follow these general rules 
when cleaning the outside of your 
computer and its components:
	 1. Shut down your computer, and 

disconnect it from the power, 
Ethernet, and modem cables. 
Laptop users should remove the 
battery.

	 2. Use a damp, soft, lint-free 
cloth to clean the computer’s 
exterior. Avoid getting 
moisture in any openings. Do 
not spray liquid directly on the 
computer. Don’t use aerosol 
sprays, solvents, or abrasives.

Really dirty computers might 
need the Simple Green treatment 
(but always spray on a paper towel, 
not directly on the computer).
Cleaning the Inside  
of Your Computer

If you aren’t in the habit 
of repairing permissions after 
installing new software, now is a 
good time to do this. Occasionally, 
user permissions associated 
with files or applications are set 
incorrectly. Each Mac comes with 
an application called Disk Utility. 
Launch that, click Verify or Repair 
Permissions, and you are all set.
Maintence

Read Mac OS X: How to force 
background maintenance tasks (logs 
and temporary items). This includes 
OS 10.2 and later (including Tiger).
http://docs.info.apple.com/article.
html?artnum=107388/

Mac OS X performs background 
maintenance tasks at certain times 
if the computer is not in sleep mode. 
If your computer is shut down or in 
sleep at the designated times, the 
maintenance does not occur. In that 
case, you may want or need to run 
these manually.

Mac OS X periodically runs 
background tasks that, in part, 
remove system files that are no 
longer needed. This includes 
purging older information from log 
files or deleting certain temporary 
items. These tasks do not run if 
the computer is shut down or in 
sleep mode. If the tasks do not 
run, it is possible that certain 
log files (such as system.log) may 
become very large. These tasks are 
scheduled for 03:15 to 05:30 in 
your computer’s local time zone. 
This is described further in “Mac 
OS X: Unexplained Disk Activity 
Produced by “find” Process”.

If your computer is normally shut 
down at night, you may choose to 
force the process to start manually.
How to Force  
Maintenance Tasks

There are two options available 
to you:

1. Use a third-party application. 
Some third-party applications allow 
you to run these tasks whenever 
you wish. These examples include: 
Macaroni by Thomas Harrington; 
Mac Janitor by Brian R. Hill; 
CronMaster by Dan Klein; and 
weRclean by Parental Advisory 
You can search for these or other 
solutions at VersionTracker.

2. Advanced: Use the terminal.
A. Open Terminal (/Applications/

Utilities). 
B. Type: sudo sh/etc/daily
(Optionally, for Mac OS X 10.2 

or later, you can use: sudo periodic 
daily.)

http://www.smalldog.com/search/do_search.php?words=protouch/
http://docs.info.apple.com/article.html?artnum=107388/
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Tip: Typing “daily” runs 
tasks normally scheduled for a 
daily interval. Type “monthly” or 

“weekly” in place of “daily” to runs 
tasks scheduled for those intervals. 
Weekly tasks usually require a 
longer time to run than others.

C. Press Return. 
D. Enter your Admin password 

when prompted, then press Return. 
E. Quit Terminal when the task 

is complete.
http://docs.info.apple.com/article.
html?artnum=107388/

Small Dog Electronics 

Sleep
To put your Mac to sleep without 

mousing up to the Apple menu, 
hold down the Command and 
Option keys and click on Eject. 

To pull up the Sleep/Restart/
Shutdown dialog box, hold down 
Control/Eject. With the S/R/SD 
dialog box open, you can use the 
following keys to activate the 
pertinent commands:

“S” puts the machine to sleep
“R” restarts the machine
The Shut Down option is 

highlighted by default. 
Clicking on the “Return” key 

will send the shutdown command.
Charlotte MacWorkshop,  

Charlotte NC

Auto-Play Your Music
When you plug a music CD into 

your Mac, iTunes launches and 
automatically begins playing the 
CD (if that’s how your preferences 
are set). If you reboot your Mac 
with a music CD already in the 
drive, this doesn’t happen. You can 
change that behavior, however, by 
way of a hidden menu option.

Go to CDs & DVDs system 
preferences, hold down the Option 
key, and click the “When You 

Insert A Music CD” pull-down 
menu. You will notice a new choice 
at the bottom called “Options.” 
Choose this, and a little pane will 
drop down, allowing you to click 
a check box: “Perform Action At 
Login.” Check this box, and any 
CD in your drive at start up will 
play automatically, as if you had just 
inserted the CD.

MacAddict Magazine

One Contextual Menu  
for Multiple Items

You can apply Contextual Menu 
items to a group of selected items. 
For example, you can select several 
items, Control/click one of them 
to display the Contextual Menu, 
and apply a Label, make Aliases, or 
Duplicate all of them.

Design Tools Monthly

Wheels within Wheels
Q: I use a Logitech MX300 

mouse, which has a scroll wheel. 
The scroll wheel doesn’t work 
with all my applications. Do you 
know why, and whether there is a 
workaround? ~ Eric Drachman

A: The fault lies with your 
applications, not with the mouse. 
Not all applications include the 
code that would allow them to 
accept input from a mouse’s scroll 
wheel. Adobe’s Acrobat Reader 5, 
for example, doesn’t respond to a 
scroll wheel, while version 6 does.

To work around this problem, 
download a copy of Alessandro Levi 
Montalcini’s $20 universal USB 
driver for mice and game pads: USB 
Overdrive. 

Although you don’t need this 
utility’s primary service — making 
an incompatible mouse work with 
a Mac — it will let you assign 
commands such as scroll up and 
scroll down to your mouse’s scroll 

wheel (or at least page up and page 
down if the application refuses to 
respond to the scroll commands).

Chris Breen’s Mac 911 
via Fat Bits, Ventura CA

Moving Windows Behind Your 
Current Window

This is a really handy tip for 
“window overload” while you’re 
working in the Finder. If you’re 
working within a window, you can 
actually move non-active windows 
that appear behind it. Just hold the 
Command key and click-and-drag 
their title bars to move them (even 
though you’re moving them, it 
doesn’t bring them to front or make 
them active). 

Better yet, if you want to 
minimize or close any of these 

“windows in the back,” you don’t 
even have to hold the Command 
key—just move your cursor over 
their inactive Close, Minimize, or 
Zoom buttons on the left-hand side 
of the title bar, and they become 
active (they will appear in their 
usual red, yellow, and green).

MouseBytes, St. Petersburg, FL

The More the....
Before disappearing on vacation 

I wrote an item extolling the virtues 
of having as many digital photo 
pixels as you can get. No sooner had 
this been published than the first 
results of serious tests of the new 8-
megapixel cameras began to appear. 

Oh dear! It would appear that 
one of the effects of cramming an 
8-megapixel sensor into the space 
previously occupied by a 5MP one 
has been a degradation of quality 
in two of the most sensitive areas 
in digital photography: image noise 
and blue/purple fringing around 
highlights. 

All 8MP cameras to date use 

http://docs.info.apple.com/article.html?artnum=107388/
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essentially the same Sony chip, and 
all are affected despite the best 
efforts of their software engineers. 
Wise heads are suggesting that if 
think you really need 8MP, you 
might be well advised to wait for 
the next generation of chips and/or 
camera firmware. 

Now, some users may rarely 
or never notice the image defects 
mentioned, but if you are the kind 
of user who plans to really exercise 
those 8MP in low-light shooting 
conditions and/or larger-than-
postcard prints, you probably will. 

For further information, I would 
recommend consulting the relevant 
camera test reports at the Digital 
Photo Review website  
<www.dpreview.com>. 
~ Steve Cooper
AUSOM News, Melbourne, Australia

Packages
There are two kinds of “packages” 

used in Mac OS X, so it is as well 
to understand what they are. The 
similarity is that both contain 
numerous files that you don’t 
normally see, but the difference is 
significant.

The first kind of package has the 
orange-colored “open box” icon 
shown at left, above, and its file 
name will normally end with .”pkg.” 
This is an “Installer package.” To get 
a clue what it is for, click once on its 
icon and from the File menu choose 

“Get Info.” If necessary, click the 
disclosure triangle beside the label 

“Open With.” You will see that this 
kind of file is set to be opened by 
the Installer utility that you have 
in your Utilities folder (inside your 
Applications folder).

It is in packages like this that 
Apple and some other developers 
supply OS updates, printer drivers, 
and the like. Double-clicking such 

a package launches the Installer, 
which extracts all the files from 
the package and installs them in 
their proper places, according to 
instructions also contained in the 
package. Once the installation 
is complete, you can either trash 
the Installer package, or keep it 
somewhere safe if you think you 
might one day need to reinstall 
whatever it contained.

The second kind of package is 
most often seen in the form of an 
application (program) such as Apple 
Works. In the olden days (i.e. under 
Mac OS 9 and earlier), applications 
were often found in special folders, 
in which were also several folders 
containing ancillary files of one 
kind or another. Havoc could be 
(and frequently was) caused by the 
accidental deletion or relocation 
of these ancillary files and folders. 
To make things worse, application 
installers often placed files in other, 
more remote folders, without the 
user’s even being aware of it. This 
made it super-easy to accidentally 
cripple an application by moving 
files that you didn’t even know 
belonged to it.

Mac OS X overcomes all these 
potential problems by bundling 
up all the bits and pieces of the 
application into a single application 
package, which is really a special 
kind of folder with the application’s 
own icon.

The special thing about an 
application package “folder” is that 
double-clicking it in the normal 
way does not open the package itself, 
but rather launches the application 
inside it.

Interestingly, you can look 
inside these packages if you want 
or need to. Simply hold down 
the Control key while you click 
on an application package (e.g. 

AppleWorks) and a contextual 
menu will pop up, from which 
you can choose “Show Package 
Contents.” Once you’ve opened 
the package in this way, you can 
release the Control key and explore 
the subfolders of the package in the 
normal way.

You will note that the 
AppleWorks package contains, 
inside a Contents folder, two 
folders named “MacOS” and 

“MacOSClassic.” Now you know 
how it happens that an OS9 version 
of AppleWorks launches if you are 
in 0S9, and an OSX version if you 
are in OSX. Both are contained in 
the application package.

Despite the fact that applications 
and all their attendant files can 
be bundled up in a package, some 
applications still depend on folders 
of ancillary components — even 
AppleWorks is guilty. There can be 
valid reasons for this (e.g. the need 
to have user-accessible folders for 
storing templates) but sometimes 
it is just a hangover from previous 
(or PC) practice. Let’s hope that the 
practice will fade out completely 
over time. ~ Steve Cooper
AUSOM News, Melbourne, Australia

Missing Packet
Q: At work, I have a Windows 

PC and a Power Mac. When 
working with recordable CDs on 
the PC, I can create folders, drag 
files, delete files, and eject the CD 
as if I’m working with a floppy disk. 
When I take the CD to my Mac, all 
the files are accessible, but that’s it. 
Is there software available for the 
Mac that will make the CD act the 
way it does on the PC?  
~ Mickey Godwin

A: What you’re describing is 
something called packet writing, 
a process by which you write to a 
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CD-R multiple times. Roxio used 
to offer a program called DirectCD 
that added packet writing 
capabilities to pre-OS X versions 
of the Mac operating system. 
Regrettably, the program has gone 
the way of the Dodo. But you can 
use Tiger’s (and Panther’s) Disk 
Utility (and Jaguar’s Disk Copy) to 
create CD-Rs that you can burn 
multiple times. 

Here’s how it works in Tiger.
Grab the files you want to put on 

the disc and place them in a single 
folder. Launch Disk Utility (in the 
folder) and choose File > New > 
Disk Image From Folder (in Panther, 
select Images > New > Image From 
Folder). In the resulting dialog box, 
navigate to the folder you created 
and click on “Image.” In the “New 
Image From Folder” dialog box that 
appears, name the image, choose 

“Read-Only” from the “Image 
Format” pop-up menu, and click on 

“Save.”
Select the image in the left 

column of the Disk Utility dialog 
box and click on “Burn.” Insert 
a blank CD as requested. If you 
don’t see any options at this point, 
click on the triangle to the right of 
the “Burn Disc In” pop-up menu 
to reveal them. Select the “Leave 
Disc Appendable” option to burn 
the material you chose as a single 
session. You’ll be able to add 
additional sessions at another time.

Now for the caveats: this method 
is convenient and free, but discs 
burned this way don’t work on 
Windows PCs because their format 
is incompatible with Microsoft’s 
operating system. In order to use 
your discs on Macs and PCs, you’ll 
need to buy one of the utilities 
that can burn cross-platform 
multisession CDs. One of the 
least expensive is toolsonTEN’s 

burnltAgainSam ($15). It features a 
simple interface and burns discs in 
the ISO 9660 Joliet format, which 
is compatible with both Macs and 
PCs. I’m also very keen on Roxio’s 
Toast Titanium. At $80 it’s not the 
cheapest utility around, but it’s 
reliable, does far more than simply 
create multisession CDs, and is less 
cumbersome than Disk Utility.

Fat Bits, Conejo Valley MUG

Desktop Printing? 
How About “Sidebar Printing?”

To create a Desktop Printer 
in Panther, in the Print & Fax 
preferences, click on “Set Up 
Printers,” and when the Printer List 
dialog appears, click on the printer 
you want as a Desktop Printer, then 
press Shift/Command/D. 

However, once you create a 
Desktop Printer, you can really 
make things convenient by clicking 
on the Desktop Printer and pressing 
Command/T, which adds this 
Desktop Printer to your Sidebar, so 
now you can drag-and-drop from 
your current window right onto the 
printer in the Sidebar. 

�e mind reels.
TMUG Insider, Pleasanton, CA

Disk Copy
Q: I just installed Mac OS 10.3 

(Panther) and want to make disk 
images of my CDs. Where is Disk 
Copy?

A: Disk Copy is gone from 
Panther. Apple incorporated Disk 
Copy’s functions into Disk Utility 
(Applications > Utilities). To create 
a disk image of a CD in Panther, 
insert the CD, launch Disk Utility, 
highlight your CD’s name in Disk 
Utility’s left window, and select 
New > Image From CD name (see 
below). Name the image and save it.

MacAddict Magazine

Mac OS X

Using the Menu Bar
�e menu bar is visible at the 

top of your desktop and shows 
menus related to the current 
application you are using. �e 
name of the current application 
appears in bold on the left side 
next to the Apple menu.

Small icons (called “status 
menus”) toward the right end of 
the menu bar show the status of 
your computer or give you quick 
access to certain features. If you 
click an icon, you can view a menu 
or perform an action. For example, 
you can click the volume icon and 
drag the slider to quickly adjust 
your computer’s volume.

You can display menu bar icons 
to see the status of your battery, 
AirPort connection, modem 
connection, and more. If a menu 
bar icon is available for a Mac OS X 
feature, you may be able to use that 
feature’s pane of System Preferences 
to select to display the icon. Some 
applications may allow you to add a 
status icon to the menu bar during 
installation.

To reveal a menu, click an icon 
or menu category, then select the 
command you want.

To rearrange the menu bar icons 
on the right, press the Command 
key and drag the icons. You cannot 
rearrange the application menus on 
the left.

You can remove status menus by 
holding down the Command key 
and dragging the icon out of the 
menu bar.

Apple Help Menu

.SEA Files
Remember .sea files from your 

old Classic days? Still have some 
floating around, but you don’t want 
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to start Classic to open them? You 
don’t have to. Just drag it to your 
StuffIt Expander icon. 
Apple Pickers MUG, Indianapolis, IN

Classic Warning
If you do not use Classic very 

often, it is a genuine pain if it starts 
to open by accident. Since Classic 
takes a while to open, it would be 
nice to find a way to have it warn 
you. There is a way. Open System 
Preferences, select Classic, and in 
the Start/Stop tab, click “Warn 
before starting Classic.”

Mouse Droppings, Corvallis, OR

Can’t Find That “Odd Character?”
Need to get an odd character for 

your writings? (I know I needed 
lower-case lambda all the time 
for my notes.) Your Mac has any 
number of other alphabets tucked 
away. You can view and use them 
selectively by selecting Edit > 
Special Characters from the Finder’s 
menu bar.

TMUG Insider, Pleasanton, CA

Keep in Dock
Have you ever looked at the 

Dock thinking an application is 
there, but you had closed it, and it 
is not in the Dock? You can ensure 
that often-used applications stay 
in the Dock. Control/click on the 
applications at some point when it is 
in the Dock. A dialog pops up and 
the first item is “Keep in Dock.”

Mouse Droppings, Corvallis, OR

Contextual Compression
OS 10.3 has a built-in 

compression utility that can 
compress files and folders into a 
zip archive. Go to the Finder and 
find a folder you’d like to compress. 
Control/click the folder and choose 

“Create Archive of ‘FolderName’” 

from the contextual menu. In a few 
moments, a .zip archive of the folder 
will appear. You can then transfer 
this compressed archive to anyone 
you wish. This tip is especially 
useful if you regularly send files 
to friends with PCs, who tend to 
be much more receptive to .zip 
archives than .sit (StuffIt) archives.

macHOME Journal

Tiger

Tiger’s Dictionary
Want to know the meaning of a 

word? OS 10.4 users can have full 
access to both the New Oxford 
American Dictionary (2nd Edition) 
and the Oxford American Writers 
Thesaurus (1st Edition). Typically 
you access the dictionary through 
Dashboard, but you can also call it 
up in select applications at anytime 
with a keyboard combination. In 
Safari, Mail and iChat (and other 
applications by Apple), just double-
click a word to highlight it and 
press Control/Command/D. A 
definition will appear right under 
the word!

macHOME HotTips 

Changes to Get Info in Tiger
Apple changed how Get Info 

works in Tiger. Selecting one 
or more items in the Finder and 
using the Get Info command 
(Command/I) shows individual Get 
Info windows for each item. If you 
select ten or more items, a single 
summary window is displayed 
instead. Selecting several items and 
using the Show Inspector command 
(Command/Option/I) displays the 
Inspector summary window. 

Also, the Inspector summary 
window floats above all of your 
open windows, displaying 

information for any Finder item you 
click on, so you can use it like an 

“always on” Get Info window.  
www.creativetechs.com

Design Tools Monthly

Sources for Automator Actions
Mac OS X 10.4 Tiger’s new 

Automator feature includes many 
Actions that let you automate the 
processing of files. To add new 
Actions, you can either write them 
yourself, or download them from 
kind-hearted developers such as:
www.apple.com/downloads/

macosx/automator/ 
www.automatorworld.com 
www.automatoractions.com 
www.automator.us

There are hundreds of free 
actions at these websites. To use one, 
copy it into [username] > Library > 
Automator. If an Automator folder 
doesn’t yet exist, create it yourself.

Design Tools Monthly

Widget Fidget
One of the more controversial 

aspects of Tiger is that widgets can 
be automatically downloaded and 
installed via Safari without your 
knowledge or consent. This will 
most certainly be changed in OS 
X 10.4.1, but until then Gregory 
Lawhorn came up with a great way 
to deal with the situation.

Leaving the philosophical issues 
behind for a moment, here’s how to 
safeguard your system.

High Security: Disable “Open 
safe files after downloading” in the 
General tab of Safari preferences. 
Files might be downloaded, but 
they will remain archived and on 
your desktop.

Medium Security: My preference 
for the moment (I happen to like 
having a widget automatically 
installed, when I know about it, 

http://www.apple.com/downloads/macosx/automator/
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that is). Go to the YourHardDisk/
Library/Widgets folder. Control/
click on it, and select “Enable 
Folder Actions.” Control/click on it 
again, and select “Attach a Folder 
Action.” Select “Add new item alert.
scpt”. Repeat this for Home/Library/
Widgets and for every user account 
on your computer.

Now when a new widget is 
added, intentionally or secretly, 
an informative dialog box will 
notify you the folder contents have 
changed, and even give you the 
option of looking at the new item. 
If you didn’t intentionally add the 
widget, trash it and you’re safe.

MacValley Voice, Northridge, CA

Safari

Easy Reminder for Safari 
Keyboard Shortcuts

Virtually every application 
that runs on Mac OS X has 
lots of shortcut keys to help you 
save a little time along the way. 
Unfortunately, most don’t provide a 
simple way to review these shortcuts. 
So, you either print out the 
shortcuts hoping you don’t misplace 
the printout, or you just use the 
ones you remember. But if you’re 
using Safari and want to bone up 
on the keyboard shortcuts available, 
just enter the following into the 
address field: file://Applications/
Safari.pp/Contents/Resources/
Shortcuts.html. When you do, 
Safari looks deep into its resource 
files and displays a page complete 
with shortcuts. Since you might not 
remember the address the next time 
you need to review the keyboard 
shortcuts, simply bookmark the 
page while you have it displayed. 
�at way, you can’t misplace it.

LIMac Forum, Long Island, NY

Safari Spellcheck
Did you know you can 

spellcheck in Safari as well? What’s 
that you say? Why would I want to 
spellcheck someone else’s webpage? 
It’s not FOR that, silly. Command/
semi-colon (;) runs spellcheck, as 
usual. Run it while in a text entry 
box on a webpage to check what 
YOU just wrote, before you post it 
to that chat board.

TMUG Insider, Pleasanton, CA

Internet

Using Two Internet Service 
Providers

I sought to set up a new iBook, 
supplied with OS X 10.3.3, to dial 
up to either of two Internet Service 
Providers. Apple’s Mac Help told 
me nothing about this; and several 
helpful people told me it was simple, 
but their details were not right. 
�e procedure is as follows. Go 
into System Preferences, and select 

“Network.” �is opens a window 
showing a small drop-down menu 
called “Location.” Click on the 
little arrow, to scroll down to “New 
Location.” �is gets to a window, 
in which the name and details 
for the ISP can be entered. Close 
the window, and save. �en go to 
Location/New Location again, to 
get a window for the second ISP. 
�e result is that the names of the 
two ISPs appear in the Location 
drop-down menu, and you choose 
here which one you want to dial up. 
~ Bruce Craven
AUSOM News, Melbourne, Australia

Bookmarks
Addresses (URLs) for web sites 

are often unmemorable, so one 
needs to record them. Every browser 
has a facility for recording URLs 

as “Bookmarks.” But they do it by 
recording the address of the web 
site you have just visited, and this 
is no help for recording an address 
from another source, such as cited 
in an email, that one may want to 
visit later. Many programs purport 
to manage URLs, but (possibly 
excepting URL Manager, which I 
haven’t tried) don’t do the job I need.

So I have done my own thing. I 
have made a list of URLs I need, in 
a small text editor window (I use 
BBEditLite as the editor), which 
I can access from a Dragon Drop 
tab. I can type, or paste, any URLs 
I want into this window. �e 
procedure then is to select (with 
the mouse) the URL required, then 

“drag and drop” it to the left end of 
the URL window in the browser. 
�is works fine, and conveniently, 
with several browsers, including 
Camino, OmniWeb, and iCab, 
but there is a problem with Safari. 
For Safari, though not the other 
browsers, the URL must include the 
http:// prefix, which I often don’t 
bother with.

If one “drag and drops” a URL 
to the desktop, this creates a small 
icon called a “webloc” (at any rate 
by system 10.3), and dragging 
this to Safari’s URL window does 
work. A “webloc” is just a little text 
file, but the software that creates it 
automatically adds the http:// prefix. 
~ Bruce Craven
AUSOM News, Melbourne, Australia

Using Google
Google is my homepage. It 

doesn’t have to be, though, because 
most browsers, like Safari, have 
Google search integrated right into 
the toolbar. But there’s a reason I 



January 2006 • Page �www.mac-hints-tips.com

have it as my homepage and that’s 
because the front page is so clean 
and simple. When I open my 
browser to randomly look up stuff, 
I’m always reassured that searching 
the internet will be a simple, 
pleasant experience.

Google is also my dictionary. 
When I type a search phrase quickly, 
I never care that a bunch of the 
words have the wrong spelling. 
Google anticipates what I was 
trying to say and provides a link to 
the search with correct spelling.

When searching, I anticipate 
what words might be on the page 
that I’m looking for. For example, 
I might want to find information 
on how to fold a newspaper into a 
pirate hat. My search term would 
be “newspaper hat folding origami 
craft pirate steps instructions” 
without the quotes. If I were to use 
the quotes, then it would look for 
the whole phrase and I would find 
nothing unless someone actually 
had that exact text on their website. 
Let’s modify this search to take 
advantage of quotes (example: 

“pirate hat” origami craft folding 
instructions).

There are also lots of special 
functions that you can use if you 
know about them.

If you type the special function 
followed by a colon and then type 
your search directly next to the 
colon, it will apply the function 
to the search. Note that the letters 
must all be in lowercase.

define: Provides definitions 
from several various sources on the 
results area. Example: define:silica 
gel, define:t-shirt.

site: Searches only within a 
certain site or only sites with certain 
words in the address.

intitle: Searches only within the 
title of pages.

intext: Searches only the text 
of websites excluding the title and 
links.

link: With this you can view all 
the pages linking to a specific page.

There are others but I won’t go 
into them all here. There are plenty 
of websites on the subject, as well as 
books.

Another thing that is awesome 
about Google is Google answers. 
This is a service that allows you 
to post a question and then 
researchers will use their awesome 
search and research talents to find 
the answer. 

The depth of the answer depends 
on how specific you are and if the 
price is worth it. You can set a price 
from $2 to $200. You can search 
this too, so it provides you with the 
answers that other people asked and 
paid $200 dollars for free. It is a 
great way to get cool information.

For more on Google, including 
search tips and more things to 
search for: www.google.com/help/

 ~ Ryan@smalldog.com
Small Dog Electronics 

Apple Mail

Multiple Return Addresses  
in Mail

Here’s a neat trick for Mail, 
which you’d never find without 
someone telling you (as someone 
else did me):

Have you wanted to be able 
to choose between two return 
addresses when sending mail? 
Perhaps you’d like sometimes to 
send mail with a business address 
and sometimes with a private one, 
depending on where you want 
replies to wind up.

The obvious way of doing this 
would seem to be to set up two 

accounts, identical except for the 
return address. 

Great idea, but it doesn’t work. 
Mail may let you do it, but you will 
find that it chokes when trying to 
check the same mail account twice 
at the same time.

Instead, open your account 
settings in Mail > Preferences > 
Accounts and enter your desired 
(multiple) return addresses into the 
Email Address field, separated by 
commas. Close and save Preferences. 
Now open a new message form and 
you will find (at left, just above the 
message field) a pop-up menu from 
which you can choose the return 
address to be used for this message.

Note that you can also have a 
pop-up menu giving you a choice of 
signatures, to go with your choice of 
return addresses. 

Open Mail > Preferences > 
Signatures and follow your nose, 
taking care to tick the box “Show 
signature menu.”

Once you do this, though, you 
do need to be careful to check that 
each outgoing message carries the 
correct return address and the 
correct signature, as you would 
wish. This extra step will soon 
become automatic if you work at it. 
~ Steve Cooper
AUSOM News, Melbourne, Australia

Send Small Pictures
Don’t send huge high-resolution 

pictures to friends in email. After 
you drag-and-drop the image into 
a new Mail document, an “Image 
Size” pop-down menu appears at 
lower right of the Mail message 
window. Click on it and select an 
image size. Of course if the recipient 
needs a large image and has a high-
speed connection, you will not be 
worrying about this.

Mouse Droppings, Corvallis, OR
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MS Excel

Add Some Color
Select a range of cells, then 

choose “AutoFormat” from the 
Format menu. Excel has several 
styles to choose from. Mix different 
styles within your document to help 
distinguish different types of data.

macHOME Journal

MS Entourage

Creating a Mail Rule
Q: In a recent edition of 

HOTTIPS, you explained how 
to create a verbal alert using 
AppleScript. I understood the tip 
until I got to point where you said 
to “create a mail rule that triggers 
the script.” How do I do that? I’m 
using Entourage. ~ Dave O

A: It’s fairly simple. In Entourage, 
choose Tools > Rules. Click “New” 
(in the top left). Once the “Edit 
Rule” window appears, give the 
rule a name. Under “IF,” choose 

“From” and then “Contains” from 
the pop-up menus. Now enter your 
colleague’s email address into the 
adjacent text field. Under “THEN,” 
choose “Run AppleScript.” A Script 
button will appear next to it. Click 
this button and choose the script 
you created. Now click “OK.” The 
next time you receive mail from 
that address, the computer will 
notify you with the verbal alert you 
created.

macHOME HotTips

MS Word

Insert and Format Symbols
For instant access to thousands 

of special symbols, like foreign 
characters and wild and crazy icons, 

open the Insert menu, choose 
“Symbol,” and look through the 
selections available with different 
fonts and subsets of fonts. After you 
insert a special character or symbol, 
you can then select it and use 

“Grow Font and Shrink Font” on it.
TMUG Insider, Pleasanton, CA

iTunes

Sound Check Redux
Q: I’d like to apply the Sound 

Check process to my iTunes library 
again. Is there a way to do it 
without removing and re-adding all 
my songs? ~ Tom Starling

A: There is, but it’s not quite 
as easy as visiting iTunes’ Audio 
preference pane and toggling the 

“Sound Check” option (which 
adjusts each song’s volume level to 
be nearly the same) on and off. The 
trick is to rebuild the iTunes library.

To do so, quit iTunes and 
navigate to the iTunes music folder 
(/your user folder/Music/iTunes). 
Move the iTunes Music Library. 
xml file to the desktop — you’ll 
need it later. Then move the iTunes 
4 Music Library file to the desktop. 
For the moment, hang on to it in 
case things go awry. When you 
launch iTunes, you’ll see that there 
isn’t a single song listed in its library. 
iTunes simply doesn’t know where 
they are.

Select File > Import and, in the 
resulting Import window, find the 
iTunes Music Library.xml file you 
moved to the desktop. Click on 

“Choose.” iTunes will populate its 
library listing with your track titles 
and restore your playlists. If the 

“Sound Check” option is selected, 
iTunes will once again apply the 
Sound Check adjustment to your 
library. If it’s not selected, then 

enable the “Sound Check” option 
to apply the effect.

Once you’re sure your songs 
are safely listed, trash the iTunes 
4 Music Library file that’s on your 
desktop. If something did go wrong, 
replace the new iTunes 4 Music 
Library file with the original one.

Fat Bits, Conejo Valley MUG

Hearing Double
There it goes again. You’re two 

minutes into Pink Floyd’s “Time,” 
and you could swear you just heard 

“Time” playing two minutes ago. 
Of course, when you like an 

artist who has produced a lot of 
albums — Bonnie Raitt, Oscar 
Peterson, Pink Floyd, Sam Cooke, 
Eminem, Ray Brown, Christopher 
Parkening, Korn, Ray Charles, Joni 
Mitchell, or U2 — it is easy to 
import a CD or download a song or 
album from the iTunes Music Store 
without realizing that you already 
have a track or two in your iTunes 
music collection. 

But now there’s an easy way to 
find those duplicate songs and, if 
you’d like, silence the echoes. With 
your Library (or even a Playlist) 
selected, simply choose “Show 
Duplicate Songs” from the Edit 
menu. When you’re done perusing 
your duplicate songs, choose “Show 
All Songs.” 

Apple eNews

Use Any Drive with iTunes
iTunes doesn’t like to write to 

CD/DVD burners that weren’t 
installed by Apple. 

However, if you install one 
yourself, or use an external burner, 
you can use PatchBurn (free) to 
convince iTunes and sometimes 
iDVD to use that burner. 

Available at www.patchburn.de/
Design Tools Monthly
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iPhoto &
iTunes

Moving Music and Pictures
Switching to a new computer? 

You’ll certainly want to make sure 
that you transfer your photo and 
music libraries intact. First, set up 
your new computer with the same 
user account name and password 
as the old computer. Now make 
sure that the old computer and 
the new computer both have the 
same versions of iTunes and iPhoto. 
Finally, drag and drop the Music 
and Pictures folder from your home 
folder on your old computer into 
your home folder on your new 
computer, replacing the existing 
folders. Now start up iTunes and 
iPhoto. Your media libraries should 
appear exactly as they were on your 
old computer.

macHOME HotTips

iPhoto

�umbs Down to �umbnails
If you use iPhoto to burn CDs, it 

burns not only the original images 
but also the thumbnail images that 
iPhoto creates. Here are 2 solutions. 
In iPhoto, create an album holding 
the pictures you want to print. Now 
select all the photos in the album 
and drag them to the blank CD 
on the desktop. View the pictures 
as film rolls (choose View > Film 
Rolls). Now insert a blank CD, and 
drag the rolls you want to print to 
it. Only the originals will copy to 
the disk.
Apple Pickers MUG, Indianapolis, IN

No Question Marks
If you order prints through 

Apple and iPhoto only to find some 
photos missing, you might want 

to review the filenames before you 
call Apple and complain. For some 
odd reason having to do with the 
software that processes your images, 
any file that contains the question 
mark (?) character in its name is 
automatically rejected from the 
order. You will not be charged for 
these images, but they won’t be 
printed. To get them printed, you 
simply need to remove the question 
mark from the filename and 
resubmit the file.

TMUG Insider, Pleasanton, CA

Import Movies
Q: I use iPhoto to import 

pictures from my digital camera, 
but what can I use to get at the 
video clips I shoot using the same 
digital camera? 

A: Most digital cameras can 
record a small quantity of video 
(of limited quality), but iPhoto 
ignores these files when you 
connect your camera and click the 

“Import” button. To get to those 
video clips, fire up Image Capture 
(/Applications/Image Capture). �is 
application will see your plugged-in 
and turned-on digital camera and 
let you import any movies you’ve 
recorded.

MacAddict Magazine

iMovie

Audio Clip Control
Q: I consider myself a veteran 

user of iMovie, but I’m vexed by 
the latest incarnation, iMovie HD. 
Before, I was always able to trim 
audio clips in the timeline viewer 
simply by hovering the pointer over 
either end of the audio clip. In the 
current version, all this does is move 
the clip. What gives? ~ John Smith

A: Apple has changed the 

behavior of audio clips. If iMovie 
HD’s Show Clip Volume Levels 
option is enabled (View > Show 
Clip Volume Levels), clicking on 
an audio file in the timeline allows 
you only to adjust the clip’s volume 
or move the file — you can’t trim 
it. Turn this option off, and you’re 
welcome to trim to your heart’s 
content. For this reason, it’s a good 
idea to memorize the Command/
Shift/L keyboard shortcut, which 
switches this option on and off. 
(You can also access this command 
by Control/clicking on an audio 
clip and choosing the command 
from the contextual menu.

Chris Breen’s Mac 911 
via Mouse Droppings, Corvallis, OR

iCal

Accessorizing iCal
Q: Is there an automatic way to 

put holidays and moon phases into 
iCal? ~ Jason Kamps 

A: With the help of iCal 
subscriptions, yes. Choose Calendar 
> Subscribe and enter the calendar’s 
URL in the sheet that appears. 
I use the site iCalShare to find 
calendars. �e site offers more than 
2,000 from schedules of pro sports 
teams to important dates in the 
history of anarchy. �e last time I 
looked, iCalShare listed 228 holiday 
calendars and enough moon-phase 
calendars to bring out the werewolf 
in anyone.

To subscribe to an iCalShare 
calendar, find one you like and click 
on the “Subscribe” link associated 
with it. iCal will launch and add 
the calendar. If you get tired of a 
particular calendar, just click on it in 
iCal’s Calendar pane and delete it.

Fat Bits, Conejo Valley MUG
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the country. Mouse Droppings is the home of Phil Russell, a respected Macintosh writer and the main source of hints and tips published by 
me over the years, as well as other MUG newsletters throughout the world.

•	 ApplePickers, newsletter of the ApplePickers MUG in Indianapolis, Indiana.

•	 AUSOM News, newsletter of Australia’s largest Macintosh User Group, Apple Mac Users’ Society of Melbourne, Australia.

•	 Charlotte MacWorkshop, newsletter of the Macintosh Users Group in Charlotte, North Carolina.

•	 FatBits, newsletter of CVMUG, the nation’s first user group. Camarillo, California

•	 LIMAC Forum, newsletter of the Long Island Mac Users Group in Seaford, New York.

•	 MacValley Voice, newsletter of the MacValley User Group in the Northridge, California.

•	 MouseBytes, newsletter of the Bay Area Macintosh Users Group in Largo, Florida.

•	 TMUG Insider, newsletter of the Tri-Valley Macintosh Users Group in Pleasanton, California.

Friends:
•	 Lynn Rybarczyk, an elementary school teacher and good friend, San Diego, California 

•	 Bob Smallman, Merrill WI

•	 Michael Tippett

Websites:
•	 Apple eNews — A free biweekly subscription-based email publication from Apple Computer.

•	 Small Dog Electronics, an Apple Specialist and resellers of Apple Macintosh computers, peripherals, and software.  
www.smalldog.com.

Publications:
•	 Jay J. Nelson’s Design Tools Monthly — An executive summary of graphic design news which includes Mac news and rumors, new software 

and hardware announcements, upcoming seminars and shows, interesting websites, and other valuable information. You may request a free 
sample copy of this monthly newsletter by going to www.design-tools.com or calling 303.543.8400.

•	 MacAddict Magazine. “A better machine. A better magazine.” Every issue of MacAddict is packed with in-depth how-to articles, fact-filled 
features, and expert reviews, plus a monthly CD of hot product demos, tutorials, freeware, and video how-to stories and interviews.  
www.macaddict.com

•	 The macHome Journal, the ultimate magazine for the Macintosh consumer, offering practical advice for everyone. macHome Journal offers 
excellent how-to articles and advice on purchases, and Hot Tips on line. www.machome.com.

•	 Macworld Magazine. The ultimate resource for Mac users. Each issue is packed with practical how-tos, in-depth features, the latest 
troubleshooting tips and tricks, industry news, future trends, and is home of Chris Breen’s Mac 911 columns.  
www.macworld.com.

Other:
•	 Apple’s Help Menu

If you are not a member of a Macintosh User Group, I highly recommend that you find one in your area and join. User groups are the greatest 
source of information and help available to all Mac users — from novices to experts. Find one in your area at apple.com/usergroups/find. 




